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Viz Engine Release Notes - 5.5

1 VizEngine5.5.1

Release Date: 2026-03-19

These are the release notes for Viz Engine version 5.5.1. This document describes the user-visible changes that have
been made to the software since release 5.5.0.

1.1 Installer Notes

See also Installer Notes 5.5.0

Note: When installing Viz Engine with the individual MSl installer and not the Viz Artist Bundle installer,
ensure all runtime dependencies are up-to-date (for example, Viz Engine does not start with an outdated
Microsoft Visual C++ 2015-2022 Redistributable (x64) version). The minimum required version is
14.40.33810 (https://aka.ms/vs/17/release/vc_redist.x64.exe).

If the installation fails with error code 1638, uninstall any existing MS Visual C++ Redistributable (x64) and
restart Windows and rerun the bundle installer.

If Microsoft Visual C++ 2015-2022 Redistributable (x64) - 14.40.33810 is already installed and Viz Engine is
not starting, the runtime installation could be damaged. Reinstall the runtime redistributable in this case.
The related installer is part of the Bundle installer.

1.2 Fixed Issues

1.2.1 Fixed Issues: General
Key Summary

VIZENG-3480 Missing scripting rendering updates on color setters (emission, diffuse, ambient, specular) for Viz
4 Scripting

VIZENG-3473 | Scroller plugin stopped working - improved initialization of Plugins and Scripts in subscenes
0

VIZENG-3468  Correct initialization of scripts in Subscenes and Geometries
9

3 issues

1.2.2 Fixed Issues: Renderer
Key Summary

VIZENG-34752 Avoid Regular and Dynamic geometry on the same container

Copyright © 2026 Vizrt Page 8


https://aka.ms/vs/17/release/vc_redist.x64.exe
https://vizrt.atlassian.net/browse/VIZENG-34804
https://vizrt.atlassian.net/browse/VIZENG-34804
https://vizrt.atlassian.net/browse/VIZENG-34730
https://vizrt.atlassian.net/browse/VIZENG-34730
https://vizrt.atlassian.net/browse/VIZENG-34689
https://vizrt.atlassian.net/browse/VIZENG-34689
https://vizrt.atlassian.net/issues/?jql=project+%3D+VIZENG+AND+issuetype+%3D+Bug+AND+status+%3D+Closed+AND+%28fixVersion+in+%28VizEngine-5.5.1%29%29+AND+%22Release+Notes+Status%22+in+%28Done%2C+Needed%29++and+resolution+in+%28Fixed%2C+Done%2C%22Test+passed%22%29++++AND+component+in+%28Core%2C+Animation%2C+CommandInterface%2C+PluginAPI%2C+Scripting%2C+Security%2C+Stage%2C+Superchannel%2C+VS%29+and+%21%28Summary+%7E+%22Black+Duck*%22%29+AND+%28labels+NOT+IN+%28Security%29+OR+labels+IS+EMPTY%29++++&src=confmacro
https://vizrt.atlassian.net/browse/VIZENG-34752
https://vizrt.atlassian.net/browse/VIZENG-34752

Key

VIZENG-34751
VIZENG-34750
VIZENG-34744

VIZENG-34683

5 issues

Viz Engine Release Notes - 5.5

Summary

Dynamic geometry calculates wrong BoundingBox

Post Process settings can no longer be animated

Empty Text with Dropshadow option can lead to crashes

Viz Engine crashes when Clip Texture Renderer is used inside Transition Logic

1.2.3 Fixed Issues: Video 10

Key
VIZENG-34681

VIZENG-34654

Summary
Rightmost column of pixels has incorrect blended colors when using 10 bit YUVA inputs

Add configuration setting to match field polarity on frame repeat with matrox outputs

2 issues

1.3 Security Updates

Key Summary
VIZENG-34736 Update VML version to mitigate security risk
1issue

1.4 Changes

See Changesin 5.5.0

1.5 Known Issues

See Known Issuesin 5.5.0

Copyright © 2026 Vizrt Page 9


https://vizrt.atlassian.net/browse/VIZENG-34751
https://vizrt.atlassian.net/browse/VIZENG-34751
https://vizrt.atlassian.net/browse/VIZENG-34750
https://vizrt.atlassian.net/browse/VIZENG-34750
https://vizrt.atlassian.net/browse/VIZENG-34744
https://vizrt.atlassian.net/browse/VIZENG-34744
https://vizrt.atlassian.net/browse/VIZENG-34683
https://vizrt.atlassian.net/browse/VIZENG-34683
https://vizrt.atlassian.net/issues/?jql=project+%3D+VIZENG+AND+issuetype+%3D+Bug+AND+status+%3D+Closed+AND+%28fixVersion+in+%28VizEngine-5.5.1%29%29+AND+%22Release+Notes+Status%22+in+%28Done%2C+Needed%29++and+resolution+in+%28Fixed%2C+Done%2C%22Test+passed%22%29+AND+component+in+%28Classic%2C+Renderer%2C+PostProcessing%2C+Text%2C+UnrealIntegration%29+and+%21%28Summary+%7E+%22Black+Duck*%22%29+AND+%28labels+NOT+IN+%28Security%29+OR+labels+IS+EMPTY%29++++&src=confmacro
https://vizrt.atlassian.net/browse/VIZENG-34681
https://vizrt.atlassian.net/browse/VIZENG-34681
https://vizrt.atlassian.net/browse/VIZENG-34654
https://vizrt.atlassian.net/browse/VIZENG-34654
https://vizrt.atlassian.net/issues/?jql=project+%3D+VIZENG+AND+issuetype+%3D+Bug+AND+status+in%28Closed%2CDone%2C%22Test+passed%22%29+AND+fixVersion+%3D+VizEngine-5.5.1+AND+component+in+%28%22I%2FO%22%2C+ClipPlayer%2CClipPlayerVML%2CIP-Streaming%2CSharedMemory%2CNDI%2CSDI%29+AND+%22Release+Notes+Status%22+in+%28Done%2C+Needed%29+and+%21%28Summary+%7E+%22Black+Duck*%22%29+AND+%28labels+NOT+IN+%28Security%29+OR+labels+IS+EMPTY%29+++++&src=confmacro
https://vizrt.atlassian.net/browse/VIZENG-34736
https://vizrt.atlassian.net/browse/VIZENG-34736
https://vizrt.atlassian.net/issues/?jql=project+%3D+VIZENG+AND+status+in%28Closed%2CDone%2C%22Test+passed%22%29+AND+fixVersion+%3D+VizEngine-5.5.1+AND+component+in+%28Core%2C+%22I%2FO%22%2C+ClipPlayer%2CClipPlayerVML%2CIP-Streaming%2CSharedMemory%2CNDI%2CSDI%29+AND+%22Release+Notes+Status%22+in+%28Done%2C+Needed%29+and+%21%28Summary+%7E+%22Black+Duck*%22%29+AND+%28labels+IN+%28Security%29%29+++++&src=confmacro
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1.5.1 General

¢ The final position and size of scaled image channels in DVE mode might change by 1 pixel after fixing
rounding issues.

e Saving a new scene with references that do not exist anymore fails. Those references need to be removed
manually to save the scene.

* Importing HDR images with special characters in its file name from a drive with 8dot3 disabled fails.

e Transition Logic scenes require to have GeomAutoFree = 1 set in the Viz Config file. With inactive
GeomAutoFree, system stability is not guaranteed.

e Interactive Applications within a GFX channel only work in DVE mode in Fullscreen or if the GFX channel has
an offset in Fullscreen. Scaled GFX channels or plug-ins that rely on screen coordinates (Graffiti) are not
supported.

* Bones and Skin live motion data tracking requires Tracking Hub 1.1.2 (released together with Viz Engine
3.11).

¢ iz Engine REST interface does not start if a user is Non-Admin (VIZENG-23386).

® On Air output shows wrong field-of-view if AuxRenderer is enabled, PP in scene editor is disabled and Viz
Engine is not in On Air mode.

* The Toggle plug-in can not handle the background loading of objects or scenes.

¢ Oversized snapshot requests (bigger than the configured output resolution) in the Classic Render Pipeline
aren't supported. Use the Viz Engine Render Pipeline instead.

® The clog command now includes all child processes. Upon abnormal end, all child processes are
terminated before a restart is attempted (VIZENG-11361).

¢ Scaling directors down can cause keyframes to be scaled down to 0.0. These values do not recover when
scaling directors up again afterwards (VIZENG-31610).

Key Summary

VIZENG-34063 = Add new deformation mode for handling more correct center shift in "Internal Tracking Mode"
VIZENG-27515 AJA10: Embedded Audio only available if SDI Input enabled

VIZENG-33562 | Allow round-trip conversion between dynamic and static geometries

VIZENG-34734  Artist scene tree edit may lead to unexpected engine crash

VIZENG-34695 = Can't change DVE delay of live input 1 when Watchdog is activated

VIZENG-29680 @ Change Audio Backend on EAS

VIZENG-32400 @ Changing Spline types is not considered in Undo/Redo

VIZENG-28452 | Consolidation of logging settings and configuration

VIZENG-34733 | Differences between VML and Matrox clip player when setting clip IN and OUT via script

Copyright © 2026 Vizrt Page 10


https://vizrt.atlassian.net/browse/VIZENG-34063
https://vizrt.atlassian.net/browse/VIZENG-34063
https://vizrt.atlassian.net/browse/VIZENG-27515
https://vizrt.atlassian.net/browse/VIZENG-27515
https://vizrt.atlassian.net/browse/VIZENG-33562
https://vizrt.atlassian.net/browse/VIZENG-33562
https://vizrt.atlassian.net/browse/VIZENG-34734
https://vizrt.atlassian.net/browse/VIZENG-34734
https://vizrt.atlassian.net/browse/VIZENG-34695
https://vizrt.atlassian.net/browse/VIZENG-34695
https://vizrt.atlassian.net/browse/VIZENG-29680
https://vizrt.atlassian.net/browse/VIZENG-29680
https://vizrt.atlassian.net/browse/VIZENG-32400
https://vizrt.atlassian.net/browse/VIZENG-32400
https://vizrt.atlassian.net/browse/VIZENG-28452
https://vizrt.atlassian.net/browse/VIZENG-28452
https://vizrt.atlassian.net/browse/VIZENG-34733
https://vizrt.atlassian.net/browse/VIZENG-34733

Key

VIZENG-27866
VIZENG-34745
VIZENG-31127
VIZENG-28344
VIZENG-34640
VIZENG-30569
VIZENG-24017
VIZENG-34789
VIZENG-29589
VIZENG-31624
VIZENG-34767
VIZENG-32399
VIZENG-29623
VIZENG-26964
VIZENG-34686
VIZENG-34824

VIZENG-33601

26 issues
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Summary

Enable individual volume control for tracks

Existing 3.x scene has different directors selected

Experimental: Reduce overall in-to-out delay in Fast Texture Mode
GH Sync: support main/replication setup

Hindi text looks different in VER pipeline

Improve Undo/Redo performance on larger Gl scenes

Improve VizEngine startup time

Incorrect handling of 10 bit YUVA inputs - 5.6 merge

Maya 2024 doesn't support Viz Maya plugin

Optimize transform update

Scenes with Alpha behave abnormally in SuperChannels transitions
Stop/Pause/Tags are not considered in Undo/Redo

Text: global config for default font style

Used lens distortion parameters not in sync with main scene

Virtual window renders wrong if inside a GFX channel and the camera is switched
Viz Engine shader performance degrades over time

VizEngine does not always switch back to GH main after main shutdown and startup

Copyright © 2026 Vizrt
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Viz Engine Release Notes - 5.5

2 VizEngine5.5.0

Release Date: 2026-02-12

These are the release notes for Viz Engine version 5.5.0. This document describes the user-visible changes that have
been made to the software since release 5.4.1.

Note: Viz Artist maintains its release notes in a separate document starting from version 3.12.0.

2.1 Installer Notes

2.1.1 General

The Software ships with a bundle installer containing all necessary components. It is recommended to use the
bundle installer when setup needs to be done manually.

¢ The Setup application (both MSI and Bundle installer) must be run in Administrator mode.

¢ Visual C++ Redistributable files are no longer part of the .msi setup file. These files are now installed with the
bundle setup application (VIZENG-13210, VIZENG-12629, VIZENG-12701).

* The bundle setup application installs or upgrades Viz Artist together with its required Visual C++
Redistributable files (VIZENG-12936, VIZENG-13804).

¢ Allfiles contained in the bundle setup application can be extracted using the /dump command line option.
This creates a sub-folder where the files are extracted (VIZENG-13020).

¢ Multiple installations of Viz Engine are not supported.

¢ Theinstaller automatically upgrades (replaces) any existing Viz Artist/Viz Engine 3.x installation. However,
downgrading is currently not supported (VIZENG-7098).

¢ |f Adobe After Effects is installed after Viz Engine, the Viz installer needs to be executed again to install the AE
plug-in (VIZENG-7876).

® The user account must have SeCreateGlobalPrivilege (SE_CREATE_GLOBAL_NAME) enabled.

* The configuration profiles shipped with Viz Engine guarantee a correct Audio/Video delay, to have a proper
lip-sync setup or a correct video wall installation. A manual configuration (for example, number of inputs,
clips, etc.) is still required, after applying these profiles (VIZENG-18861).

® To use Global Illumination in Viz Artist/Viz Engine, at least Direct X version 9 is required. (VIZENG-19983).

e Download the DirectX End-User Runtimes (June 2010):

¢ Microsoft Download Link: Download DirectX End-User Runtimes (June 2010) from Official Microsoft
Download Center
e Extract the files:
® Run the downloaded .exe and select a folder for extraction.
* After extraction, navigate to that folder and run DXSETUP.exe.
e Complete the installation:
¢ Thisinstalls all missing legacy DLLs, including d3dx9_43.dll.

* The Basic, DataPool, PixelFX, Viz Maps, Viz Extension and Viz Socialize plug-ins are released together with Viz
Engine, starting with version 4.0.0, and are included in the bundle installer. The basic plug-ins are installed
by default.
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Note: In case of installing Viz Engine with the individual MSl installer and not the Viz Artist Bundle installer,
ensure all runtime dependencies are up-to-date (for example, Viz Engine does not start with an outdated
Microsoft Visual C++2015-2022 Redistributable (x64) version). The minimum required version is
14.40.33810 (https://aka.ms/vs/17/release/vc_redist.x64.exe).

If Microsoft Visual C++2015-2022 Redistributable (x64) - 14.40.33810 is already installed and Viz Engine is
not starting, the runtime installation could be damaged. Reinstall the runtime redistributable in this case.
The related installer is part of the Bundle installer.

Information: In case of upgrading from previously installed versions, and the upgraded version comes
with a new CodeMeter version, make sure that all the applications installed using CodeMeter on the same
host, are still running.

2.1.2 Windows

This software was tested to run on Windows 11 (LTSC 24H2), Windows 10 (LTSC 1809, 21H2) and Server 2019

and Server 2022.

Windows transparency effects should be turned off (former known as Aero). In Windows 10 set Show

transparency in Windows to Off in Settings > Display and Transparency effectsto Off in Settings >

Personalization > Colors > More options.

Power management and hibernation mode must be turned off under Windows. You can execute
powercfg -h off toremove hiberfil.sys from the hard disk.

Itis recommended to install the latest Windows Security Updates and Patches, except NVIDIA updates.
Installations on Windows 10 are only supported on their respective supported hardware (see Supported

Systems).

.NET framework 4.5 or higher is required (VIZENG-6036).

The minimum Windows Installer version is now 5.0.0 (VIZENG-10146).

To run Viz Engine without Administrator privileges, you need to grant the following permissions:

SelncreaseBasePriorityPrivilege
SeCreateGlobalPrivilege
SeCreatePagefilePrivilege
SelncreaseWorkingSetPrivilege

2.1.3 UAC

Viz Engine is UAC aware. Configuration files, profiles, log files, and additional files are stored in
%VIZ_PROGRAMDATA%, which defaults to %ProgramData%\Vizrt\VizEngine. Temporary data is stored in
%VIZ_TEMPDATA% which defaults to % TMP%\Vizrt\VizEngine. The default value can be changed in the
command line of viz.exe.

Existing Lens files are copied from %ProgramFiles% install folder to the new UAC

aware %ProgramData% folder during installation (VIZENG-8757).

Existing Viz configuration files are copied from %ProgramFiles% install folder to the new UAC aware
%ProgramData% folder during installation (VIZENG-7472).
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2.1.4 Cinema4D

¢ Cinema 4D LiveLink Installation: The installer searches the following location first: %ProgramFiles%
\MAXON\CINEMA 4D R16\plugins (VIZENG-7965).

¢ Cinema 4D LiveLink package can be installed any time later by using Viz Artist Installer in Repair mode. Its
installation folder is not selectable anymore (VIZENG-8996).

¢ Cinema 4D R23 or newer: LiveLink plug-in is available at %ProgramFiles%\Vizrt\VizEngine\CINEMA 4D
LiveLink\R23 (VIZENG-25344).

2.2 New Features
2.2.1 Key Features
Key Summary

No issues found

2.2.2 New Features: General

Key Summary

No issues found

2.2.3 New Features: Renderer

Key Summary

No issues found

2.2.4 New Features: Video 10

Key Summary

No issues found
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2.3 Fixed Issues

2.3.1 Fixed Issues: General
Key Summary

VIZENG-3480 ' Missing scripting rendering updates on color setters (emission, diffuse, ambient, specular) for Viz
4 Scripting

VIZENG-3473  Scroller plugin stopped working - improved initialization of Plugins and Scripts in subscenes
0

VIZENG-3468  Correct initialization of scripts in Subscenes and Geometries
9

3 issues

2.3.2 Fixed Issues: Renderer
Key Summary

VIZENG-34752  Avoid Regular and Dynamic geometry on the same container

VIZENG-34751 Dynamic geometry calculates wrong BoundingBox

VIZENG-34750  Post Process settings can no longer be animated

VIZENG-34744  Empty Text with Dropshadow option can lead to crashes

VIZENG-34730  Scroller plugin stopped working - improved initialization of Plugins and Scripts in subscenes
VIZENG-34689  Correct initialization of scripts in Subscenes and Geometries

VIZENG-34683  Viz Engine crashes when Clip Texture Renderer is used inside Transition Logic

7 issues

2.3.3 Fixed Issues: Video IO
Key Summary

VIZENG-34681  Rightmost column of pixels has incorrect blended colors when using 10 bit YUVA inputs

VIZENG-34654 | Add configuration setting to match field polarity on frame repeat with matrox outputs
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2 issues

2.4 Security Updates

Key Summary
VIZENG-34736 Update VML version to mitigate security risk
1 issue

2.5 Changes

See Changesin 5.5.0

2.6  Known Issues

See Known Issuesin 5.5.0

2.6.1 General

* The final position and size of scaled image channels in DVE mode might change by 1 pixel after fixing
rounding issues.

¢ Saving a new scene with references that do not exist anymore fails. Those references need to be removed
manually to save the scene.

¢ Importing HDR images with special characters in its file name from a drive with 8dot3 disabled fails.

e Transition Logic scenes require to have GeomAutoFree = 1 set in the Viz Config file. With inactive
GeomAutoFree, system stability is not guaranteed.

* Interactive Applications within a GFX channel only work in DVE mode in Fullscreen or if the GFX channel has
an offset in Fullscreen. Scaled GFX channels or plug-ins that rely on screen coordinates (Graffiti) are not
supported.

* Bones and Skin live motion data tracking requires Tracking Hub 1.1.2 (released together with Viz Engine
3.11).

e Viz Engine REST interface does not start if a user is Non-Admin (VIZENG-23386).

® On Air output shows wrong field-of-view if AuxRenderer is enabled, PP in scene editor is disabled and Viz
Engine is not in On Air mode.

* The Toggle plug-in can not handle the background loading of objects or scenes.

¢ Oversized snapshot requests (bigger than the configured output resolution) in the Classic Render Pipeline
aren't supported. Use the Viz Engine Render Pipeline instead.
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® The clog command now includes all child processes. Upon abnormal end, all child processes are
terminated before a restart is attempted (VIZENG-11361).

¢ Scaling directors down can cause keyframes to be scaled down to 0.0. These values do not recover when
scaling directors up again afterwards (VIZENG-31610).

Key

VIZENG-34063

VIZENG-27515

VIZENG-33562

VIZENG-34734

VIZENG-34695

VIZENG-29680

VIZENG-32400

VIZENG-28452

VIZENG-34733

VIZENG-27866

VIZENG-34745

VIZENG-31127

VIZENG-28344

VIZENG-34640

VIZENG-30569

VIZENG-24017

VIZENG-34789

VIZENG-29589

VIZENG-31624

VIZENG-34767

VIZENG-32399

Summary

Add new deformation mode for handling more correct center shift in "Internal Tracking Mode"
AJA10: Embedded Audio only available if SDI Input enabled

Allow round-trip conversion between dynamic and static geometries

Artist scene tree edit may lead to unexpected engine crash

Can't change DVE delay of live input 1 when Watchdog is activated

Change Audio Backend on EAS

Changing Spline types is not considered in Undo/Redo

Consolidation of logging settings and configuration

Differences between VML and Matrox clip player when setting clip IN and OUT via script
Enable individual volume control for tracks

Existing 3.x scene has different directors selected

Experimental: Reduce overall in-to-out delay in Fast Texture Mode

GH Sync: support main/replication setup

Hindi text looks different in VER pipeline

Improve Undo/Redo performance on larger Gl scenes

Improve VizEngine startup time

Incorrect handling of 10 bit YUVA inputs - 5.6 merge

Maya 2024 doesn't support Viz Maya plugin

Optimize transform update

Scenes with Alpha behave abnormally in SuperChannels transitions

Stop/Pause/Tags are not considered in Undo/Redo
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Key

VIZENG-29623
VIZENG-26964
VIZENG-34686
VIZENG-34824

VIZENG-33601

26 issues
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Summary

Text: global config for default font style

Used lens distortion parameters not in sync with main scene

Virtual window renders wrong if inside a GFX channel and the camera is switched
Viz Engine shader performance degrades over time

VizEngine does not always switch back to GH main after main shutdown and startup
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3 VizEngine5.5.0

Release Date: 2026-02-12

These are the release notes for Viz Engine version 5.5.0. This document describes the user-visible changes that have
been made to the software since release 5.4.1.

Note: Viz Artist maintains its release notes in a separate document starting from version 3.12.0.

3.1 Installer Notes

3.1.1 General

The Software ships with a bundle installer containing all necessary components. It is recommended to use the
bundle installer when setup needs to be done manually.

¢ The Setup application (both MSI and Bundle installer) must be run in Administrator mode.

¢ Visual C++ Redistributable files are no longer part of the .msi setup file. These files are now installed with the
bundle setup application (VIZENG-13210, VIZENG-12629, VIZENG-12701).

* The bundle setup application installs or upgrades Viz Artist together with its required Visual C++
Redistributable files (VIZENG-12936, VIZENG-13804).

¢ Allfiles contained in the bundle setup application can be extracted using the /dump command line option.
This creates a sub-folder where the files are extracted (VIZENG-13020).

¢ Multiple installations of Viz Engine are not supported.

¢ Theinstaller automatically upgrades (replaces) any existing Viz Artist/Viz Engine 3.x installation. However,
downgrading is currently not supported (VIZENG-7098).

¢ |f Adobe After Effects is installed after Viz Engine, the Viz installer needs to be executed again to install the AE
plug-in (VIZENG-7876).

® The user account must have SeCreateGlobalPrivilege (SE_CREATE_GLOBAL_NAME) enabled.

* The configuration profiles shipped with Viz Engine guarantee a correct Audio/Video delay, to have a proper
lip-sync setup or a correct video wall installation. A manual configuration (for example, number of inputs,
clips, etc.) is still required, after applying these profiles (VIZENG-18861).

® To use Global Illumination in Viz Artist/Viz Engine, at least Direct X version 9 is required. (VIZENG-19983).

e Download the DirectX End-User Runtimes (June 2010):

¢ Microsoft Download Link: Download DirectX End-User Runtimes (June 2010) from Official Microsoft
Download Center
e Extract the files:
® Run the downloaded .exe and select a folder for extraction.
* After extraction, navigate to that folder and run DXSETUP.exe.
e Complete the installation:
¢ Thisinstalls all missing legacy DLLs, including d3dx9_43.dll.

* The Basic, DataPool, PixelFX, Viz Maps, Viz Extension and Viz Socialize plug-ins are released together with Viz
Engine, starting with version 4.0.0, and are included in the bundle installer. The basic plug-ins are installed
by default.
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Note: In case of installing Viz Engine with the individual MSl installer and not the Viz Artist Bundle installer,
ensure all runtime dependencies are up-to-date (for example, Viz Engine does not start with an outdated
Microsoft Visual C++2015-2022 Redistributable (x64) version). The minimum required version is
14.40.33810 (https://aka.ms/vs/17/release/vc_redist.x64.exe).

If Microsoft Visual C++2015-2022 Redistributable (x64) - 14.40.33810 is already installed and Viz Engine is
not starting, the runtime installation could be damaged. Reinstall the runtime redistributable in this case.
The related installer is part of the Bundle installer.

Information: In case of upgrading from previously installed versions, and the upgraded version comes
with a new CodeMeter version, make sure that all the applications installed using CodeMeter on the same
host, are still running.

3.1.2 Windows

This software was tested to run on Windows 11 (LTSC 24H2), Windows 10 (LTSC 1809, 21H2) and Server 2019

and Server 2022.

Windows transparency effects should be turned off (former known as Aero). In Windows 10 set Show

transparency in Windows to Off in Settings > Display and Transparency effectsto Off in Settings >

Personalization > Colors > More options.

Power management and hibernation mode must be turned off under Windows. You can execute
powercfg -h off toremove hiberfil.sys from the hard disk.

Itis recommended to install the latest Windows Security Updates and Patches, except NVIDIA updates.
Installations on Windows 10 are only supported on their respective supported hardware (see Supported

Systems).

.NET framework 4.5 or higher is required (VIZENG-6036).

The minimum Windows Installer version is now 5.0.0 (VIZENG-10146).

To run Viz Engine without Administrator privileges, you need to grant the following permissions:

SelncreaseBasePriorityPrivilege
SeCreateGlobalPrivilege
SeCreatePagefilePrivilege
SelncreaseWorkingSetPrivilege

3.1.3 UAC

Viz Engine is UAC aware. Configuration files, profiles, log files, and additional files are stored in
%VIZ_PROGRAMDATA%, which defaults to %ProgramData%\Vizrt\VizEngine. Temporary data is stored in
%VIZ_TEMPDATA% which defaults to % TMP%\Vizrt\VizEngine. The default value can be changed in the
command line of viz.exe.

Existing Lens files are copied from %ProgramFiles% install folder to the new UAC

aware %ProgramData% folder during installation (VIZENG-8757).

Existing Viz configuration files are copied from %ProgramFiles% install folder to the new UAC aware
%ProgramData% folder during installation (VIZENG-7472).

Copyright © 2026 Vizrt Page 20


http://Dot.NET
https://aka.ms/vs/17/release/vc_redist.x64.exe

3.1.4 Cinema4D

Viz Engine Release Notes - 5.5

¢ Cinema 4D LiveLink Installation: The installer searches the following location first: %ProgramFiles%

\MAXON\CINEMA 4D R16\plugins (VIZENG-7965).

¢ Cinema 4D LiveLink package can be installed any time later by using Viz Artist Installer in Repair mode. Its
installation folder is not selectable anymore (VIZENG-8996).
¢ Cinema 4D R23 or newer: LiveLink plug-in is available at %ProgramFiles%\Vizrt\VizEngine\CINEMA 4D

LiveLink\R23 (VIZENG-25344).

3.2 Driver Versions

These are the recommended driver versions for various hardware components:

Vendor

NVIDIA Blackwell, Ada Lovelace, Ampere, Turing,
Volta, Pascal and Maxwell GPUs

NVIDIA Kepler GPUs

Matrox Topology based boards
Bluefish

Bluefish Supernova Firmware
AJA

Codemeter Runtime Kit

AV PCL/PCI Plura Timecode Reader

3.2.1 NVIDIA Drivers

Driver Version

573.76

473.47 (419.17 for older boards)
11.2.101.2608 (LTS)

6.6.1.4

162

16.1.0.3 (Firmware 2021/06/23)
8.40a

5.34

o Information: Please refer to https://nvidia.custhelp.com/app/answers/detail/a_id/4777/~/nvidia-dch/
standard-display-drivers-for-windows-10-faq for information about the DCH and Standard driver versions

and how to install a missing NVIDIA control panel.

NVIDIA driver 573.76 is recommended for GPUs with Blackwell, Ada Lovelace Technology. Ampere, Turing, Volta,
Pascal or Maxwell Technology cards have been tested with 573.76 only. A driver upgrade is not recommended in
general. Kepler GPUs are not recommended anymore, however they might still work using older driver version
473.47. Boards that do not support this version of the driver should use rev. 419.17.

NVIDIA Driver Configuration (Manage 3D Settings):
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Setting
Vertical sync Force Off (except Videowall and systems without video hardware).

Unified Back Buffer Off

Power management Prefer maximum performance
mode
Antialiasing mode Enhance the application setting

Antialiasing setting 4x (4xMS)

Profile Workstation App - Dynamic Streaming profile (for systems with video
hardware)
3D App - Video Editing (for systems without video hardware)

€ Important: Viz Engine will not start if an outdated driver is used.

3.2.2 Matrox Drivers

¢ For Matrox video cards, driver version 11.2.101.2608 (LTS) is required. This version is mandatory. Pre-release
versions are not supported.

¢ Uninstall previous versions of Matrox DSXUtils prior to installing this driver.

e Install drivers (DSX-TopologyUtils.exe) only from a local drive.

® Reboot between uninstall and install of drivers, and another time after the installation has finished.

¢ The VfW codecs are included in this driver, so uninstall previous versions of the Matrox VfW codecs and do
not install any Matrox VfW codecs over the regular driver installation.

3.2.3 Other Drivers

® The latest firmware for Supernova and Supernova S+ is 162.

The latest firmware for Neutron is 1i20 35. There is no longer linlout firmware.
® The recommended firmware for AJA |04K+ devices is 2021/06/23.

® The recommended driver version for Plura AV timecode reader cards is 5.34.

Please refer to the Viz Engine Administrator Guide for which drivers and driver settings to use.

Given that a supported Matrox device is installed, the following codecs are supported for post-rendering with
MatroxFileWriter and the ClipOut channels:

¢ RLE (animation), playback only
e H.264

Apple ProRes

e HDV

XDCam
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* DVCPro
e DNxHD (4849)
¢ XAVC (UHD requires M264 board)

3.3 Upgrade Notes

¢ All plug-in installers are installed per-machine starting with 5.2.0. Uninstalling all previous per-user plug-in
installations before upgrading is recommended to avoid duplicated installer entries.

e Existing Viz 3 configuration files, Genlock and IP configuration settings are migrated automatically by Viz
Engine.

® The old Shared Memory output is not supported on the Viz Engine Pipeline.

¢ Dueto changes in the video 10 part, ring buffer size for interlaced virtual studio setups might require a higher
ring buffer setting. Existing configuration file(s) might need to be adapted.

* The command interface is not locale-aware. Special regional settings like a semicolon within float numbers

do not work. You need to use a regular ".

0 Information: Viz Engine is not forward-compatible. Opening scenes created in this version of Viz Engine
might drop warnings when opening in previous versions. A scene saved with this version might look
different if you open it in a previous version. This affects scenes containing more than four streaming
channels.

3.3.1 Licensing Model

¢ The CodeMeter Runtime (installed with the bundle installer) is required to use the WIBU license system.
Details can be found in the manual in section "WIBU-based Licensing System". Please refer to the Vizrt
Licensing documentation on how to apply a license container.

® Cloud-based installations require a license server; standalone cloud installations are not supported.

3.3.2 Other Upgrade Notes

* NVIDIA Tesla Grid K2 Support was removed because no up-to-date drivers are available anymore.

¢ Lens distortion uses a slightly different norm since revision 54263. If you need older lens files, please
use use_lens_compatibility_mode = 1 inthe configfile.

e Viz Artist is now being started by the Viz Engine process and not by command file anymore. If you
start viz.exe and VizGui.exe independently, the Restart Current option fails.

A 64-bit version of each codec must be installed to work with Softclip64. Most codecs come with an installation
manual on how to install them correctly.

Softclip64 has been tested to work with the following 64-bit codecs:

¢ HuvYuff Version 2.1.1
¢ Lagarith Version 1.3.27
* Newtek SpeedHQ
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3.4 Virtual Environments

The following GPUs have been tested in virtualized environments, the listed driver version is the one being used.
The following GPUs are currently supported (Kepler are only supported in the Classic Render Pipeline):

Model Driver
NVIDIA L4 573.07
NVIDIA A10G 573.07
NVIDIA T4 Tensor Core 573.07
NVIDIA Tesla V100 431.79 GRIDY.1
NVIDIA A40 @ 572.60
NVIDIA RTX6000 572.60

Platform

AWS (g6 instances, gr6 instances)
AWS (g5 instances)

AWS (g4dn instances)

AWS (p3 instances) (M

vSphere 7.0 and 8.0

vSphere 7.0 and 8.0

(@) |nstance not supported on Windows Server 2025 or higher (legacy uefi boot).

Viz Engine has been tested to run in the following virtual environments:

Amazon Cloud (AWS)

® Amazon EC2 G5 Instances
¢ Amazon EC2 G4dn Instances
® Amazon EC2 G3 Instances

Microsoft Azure (1)

e Standard_NCv3 Series
e Standard NV Series

fra.me/nutanix )

VMWare ESXi (6.0(1, 6.50(1, 7.02,
8.0.2)

Alibaba Cloud (I

Viz Engine Render Pipeline Classic Render Pipeline

000

(/]
(/]
not tested

o

not tested
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Viz Engine Render Pipeline Classic Render Pipeline

(1) Tested with Engine 5.0.0 only

A\ Note: Backup and Restore on Azure systems are currently not supported.

3.5 New Features

3.5.1 Key Features

Key Summary
VIZENG-34281 VizEngine-5.5.0 - Renderer Improvements
VIZENG-33974 Viz Engine 5.5.0 - HDR Improvements

2 issues

3.5.2 New Features: General
Key Summary
VIZENG-34169 Add command to simulate picking and retrieve container id(s) at specific position
VIZENG-34518 Applying trash matte to Live/clip texture before sharing over SMURF
VIZENG-32284 Custom icons for script plugins
VIZENG-34254 HDR: support automatic colorspace conversion in shader plugins
VIZENG-31955 Improve messages when reading/writing the config file in the console
VIZENG-34631 Interactivity support for web channels in texture mode
VIZENG-34250 Introduce commands to get the process id, instance and gpu
VIZENG-33618 LayerPlugin: add and remove by name commands
VIZENG-30048 Make Tracking Hub adapter active by default

VIZENG-34354 Move control channels of a subscene in a specific location of the main scene
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https://vizrt.atlassian.net/browse/VIZENG-33618
https://vizrt.atlassian.net/browse/VIZENG-33618
https://vizrt.atlassian.net/browse/VIZENG-30048
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Key

VIZENG-33571
VIZENG-34268
VIZENG-34553

VIZENG-33620

14 issues
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Summary

Reintegrate Shared Texture feature for Webchannels and Browser Plugin
Renderer: texture color read script api

Renderer: texture readback should honor automatic color conversion (HDR)

Web Channel / Browser Plugin to embed audio

3.5.3 New Features: Renderer

Key

VIZENG-33779

VIZENG-34120

VIZENG-34033

VIZENG-34143

VIZENG-31745

VIZENG-34426

VIZENG-32261

VIZENG-33712

VIZENG-34245

VIZENG-34254

VIZENG-33807

VIZENG-30048

VIZENG-34246

VIZENG-34268

VIZENG-34553

Summary

Add tessellation to the Extrusion Modifier

Add Volumetric-Light as feature to the renderer

Allow disabling Ligatures from Text in VER

Built-in text drop shadow effect

Consider Gamma Correction in Material Definition Icon Generation
Create snapshot in the configured color space

Extend information in clog

GFX channel should behave as Clip/Live for colorimetry conversions
HDR: support automatic colorspace conversion in runtime shader
HDR: support automatic colorspace conversion in shader plugins
Improve Text behavior when there is no content entered

Make Tracking Hub adapter active by default

Renderer: add textureslot support to runtime shaders

Renderer: texture color read script api

Renderer: texture readback should honor automatic color conversion (HDR)
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https://vizrt.atlassian.net/browse/VIZENG-34033
https://vizrt.atlassian.net/browse/VIZENG-34143
https://vizrt.atlassian.net/browse/VIZENG-34143
https://vizrt.atlassian.net/browse/VIZENG-31745
https://vizrt.atlassian.net/browse/VIZENG-31745
https://vizrt.atlassian.net/browse/VIZENG-34426
https://vizrt.atlassian.net/browse/VIZENG-34426
https://vizrt.atlassian.net/browse/VIZENG-32261
https://vizrt.atlassian.net/browse/VIZENG-32261
https://vizrt.atlassian.net/browse/VIZENG-33712
https://vizrt.atlassian.net/browse/VIZENG-33712
https://vizrt.atlassian.net/browse/VIZENG-34245
https://vizrt.atlassian.net/browse/VIZENG-34245
https://vizrt.atlassian.net/browse/VIZENG-34254
https://vizrt.atlassian.net/browse/VIZENG-34254
https://vizrt.atlassian.net/browse/VIZENG-33807
https://vizrt.atlassian.net/browse/VIZENG-33807
https://vizrt.atlassian.net/browse/VIZENG-30048
https://vizrt.atlassian.net/browse/VIZENG-30048
https://vizrt.atlassian.net/browse/VIZENG-34246
https://vizrt.atlassian.net/browse/VIZENG-34246
https://vizrt.atlassian.net/browse/VIZENG-34268
https://vizrt.atlassian.net/browse/VIZENG-34268
https://vizrt.atlassian.net/browse/VIZENG-34553
https://vizrt.atlassian.net/browse/VIZENG-34553

Key

VIZENG-34427
VIZENG-34119
VIZENG-34416
VIZENG-34128
VIZENG-34385

VIZENG-33620

21 issues
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Summary

Screenspace UVs for textureslot

UE Integration: Disable subsystems when not in use

Update Web Channel Texture via Pixel Buffer

Viz Engine Renderer Image Background Loading Suport

VSL color structs should support values > 1.0 for HDR (Phong Materials)

Web Channel / Browser Plugin to embed audio

3.5.4 New Features: Video 10

Key

VIZENG-34633
VIZENG-34573
VIZENG-34438
VIZENG-34304
VIZENG-34272
VIZENG-34258
VIZENG-34062
VIZENG-34032
VIZENG-33622
VIZENG-33200

VIZENG-32269

11 issues

Summary

Page Navigation for Webchannels

Allow Fill+Key output in large canvas mode

Allow 0.0.0.0 as source address in source specific multicasting
Add flood protection to NDI input performance warnings
Parallel output: allow more than 2 program outputs

Parallel output: common StillPreview interface

Colorimetry handling in VML and Matrox Clip Player

Support HDR in SMURF inputs and outputs

Upgrade Bluefish driver to latest version (6.6.1.4)

Config flag to supress NDI messages

VML Player in VizOne workflow
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3.6 Fixed Issues

3.6.1 Fixed Issues: General

Key

VIZENG-34519

VIZENG-34504

VIZENG-34487

VIZENG-34462

VIZENG-34412

VIZENG-34386

VIZENG-34350

VIZENG-34294

VIZENG-34221

VIZENG-34209

VIZENG-34123

VIZENG-34094

VIZENG-34093

VIZENG-33625

VIZENG-33470

VIZENG-33414

VIZENG-32808

VIZENG-32630

VIZENG-32623

VIZENG-31959

Summary

Update compute shader sample plugin for instancing

TextBG does not work if geometry is replaced

Audio Clips looped in the stage are played only once

Artist does not display the tree of specific scene (empty names on cnt)
PreProcessingTextureRenderer: Can not handle images from Filesystem
Containers/Values clear out if scripts are not compiled

Significant increase in scene loading time

VSL: Possible memory corruption in URLDecode()

Wall engine running with FULLSCREEN 59.94Hz runs at 50Hz in Software 1/0 mode
Scene with ezJavascript plugin crashes when used inside a GFX channel

Specific GLB file fails to import

Subscene director cannot be moved

IMAGE SET fails for some textures

3 x Cefwebchannelprocess.exe processes start when starting viz.exe with "-C"
V-Sync is broken inside Browser and WebChannel

Renderer: DVE placeholder not visible in Front or Back layer

Precision Keyer Aux output not working without Matrox board

Super Channels Output Resolution is not saved and always use Engine output Resolutio
Assets flicker on video wall system

Events don't work in WebRTC when in no-Ul mode
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20 issues
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3.6.2 Fixed Issues: Renderer

Key

VIZENG-34559
VIZENG-34478
VIZENG-34424
VIZENG-34402
VIZENG-34367

VIZENG-34308

VIZENG-34277
VIZENG-34261
VIZENG-34230
VIZENG-34200
VIZENG-34122
VIZENG-34091
VIZENG-33846
VIZENG-33684
VIZENG-33212

VIZENG-31946

16 issues

Summary

Shadow Rendering causes differences in VER after upgrade

Superchannel has wrong transition shader on save/reload under specific circumstances
Bits per channel has affect on Classic scenes inside VER preset scene
DynamicGeometry: node animation channels appear twice in director

Renderer: disabling color limits breaks colors

Frame glitches occur when switching cameras in an XR application using Unreal and
-RenderOffscreen

[MIGRATION] Text fgColor keyframes not preserved when 3.14.5 scene is opened in 5.4
TextFX get cropped out when used with Razor draw as texture option

TextBG plugin does not work on DynamicGeometry

Various text color update issues

Non-vizrt project settings not saving with UEMedia plugin active

Text underline not getting blurred along with Razor text

Videowall shows flipped image when panned 180 degrees

Trio Cursor is 1 character off

Unreal: Control plugins have wrong VDF structure / types

Renderer: opaque materials affects key in overlay sequence
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3.6.3 Fixed Issues: Video IO

Key Summary

VIZENG-34632 ST 2110 audio and ancillary data connectors are allocated even when not configured (5.5)
VIZENG-34525 = UHD output with x.mio3 in 4in/8out configuration

VIZENG-34520  Bad audio quality in 2110 setups when Live channel aux audio is passed to SMURF channel
VIZENG-34295  No audio output when using clip channel with Bluefish

VIZENG-34035 = When using IGMPv3 audio and ancillary data flows don't store the source IP address

VIZENG-31669  Errors printed while playing HEVC clip

6 issues

3.7 Security Updates

Key Summary
VIZENG-34334 Update Browser CEF plug-in due to zero-day exploit (CVE-2025-13223)
1 issue

3.8 Changes

3.8.1 Upcoming Changes

* NVIDIA has announced that drivers 580.xx are the latest ones to support Maxwell and Pascal architectures.
e Support for Windows 10 LTSC 1809 will be dropped.

3.8.2 Changes: General

* NVIDIA Tesla M60 VGPU support has been removed.
¢ Windows Server 2019 VGPU support has been removed.
® ChromaFX license has been renamed to Precision Keyer.
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3.8.3 Changes: Renderer

Using Tracking Hub is now enabled by default in Configuration.
NVIDIA Kepler GPUs were set as deprecated (NVIDIA isn't supporting Kepler boards in newer driver versions
anymore).

3.8.4 Changes: VideolO

Note: The Matrox channel mapping format has been updated in the configuration file. Old config files are
migrated automatically during startup.

3.9

Known Issues

3.9.1 General

Key

The final position and size of scaled image channels in DVE mode might change by 1 pixel after fixing
rounding issues.

Saving a new scene with references that do not exist anymore fails. Those references need to be removed
manually to save the scene.

Importing HDR images with special characters in its file name from a drive with 8dot3 disabled fails.
Transition Logic scenes require to have GeomAutoFree = 1 set in the Viz Config file. With inactive
GeomAutoFree, system stability is not guaranteed.

Interactive Applications within a GFX channel only work in DVE mode in Fullscreen or if the GFX channel has
an offset in Fullscreen. Scaled GFX channels or plug-ins that rely on screen coordinates (Graffiti) are not
supported.

Bones and Skin live motion data tracking requires Tracking Hub 1.1.2 (released together with Viz Engine
3.11).

Viz Engine REST interface does not start if a user is Non-Admin (VIZENG-23386).

On Air output shows wrong field-of-view if AuxRenderer is enabled, PP in scene editor is disabled and Viz
Engine is notin On Air mode.

The Toggle plug-in can not handle the background loading of objects or scenes.

Oversized snapshot requests (bigger than the configured output resolution) in the Classic Render Pipeline
aren't supported. Use the Viz Engine Render Pipeline instead.

The clog command now includes all child processes. Upon abnormal end, all child processes are
terminated before a restart is attempted (VIZENG-11361).

Scaling directors down can cause keyframes to be scaled down to 0.0. These values do not recover when
scaling directors up again afterwards (VIZENG-31610).

Summary

VIZENG-34063 ' Add new deformation mode for handling more correct center shift in "Internal Tracking Mode"
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Key

VIZENG-27515

VIZENG-33562

VIZENG-34734

VIZENG-34695

VIZENG-29680

VIZENG-32400

VIZENG-28452

VIZENG-34733

VIZENG-27866

VIZENG-34745

VIZENG-31127

VIZENG-28344

VIZENG-34640

VIZENG-30569

VIZENG-24017

VIZENG-34789

VIZENG-29589

VIZENG-31624

VIZENG-34767

VIZENG-32399

VIZENG-29623

VIZENG-26964

VIZENG-34686

Viz Engine Release Notes - 5.5

Summary

AJA10: Embedded Audio only available if SDI Input enabled

Allow round-trip conversion between dynamic and static geometries
Artist scene tree edit may lead to unexpected engine crash

Can't change DVE delay of live input 1 when Watchdog is activated
Change Audio Backend on EAS

Changing Spline types is not considered in Undo/Redo
Consolidation of logging settings and configuration

Differences between VML and Matrox clip player when setting clip IN and OUT via script
Enable individual volume control for tracks

Existing 3.x scene has different directors selected

Experimental: Reduce overall in-to-out delay in Fast Texture Mode
GH Sync: support main/replication setup

Hindi text looks different in VER pipeline

Improve Undo/Redo performance on larger Gl scenes

Improve VizEngine startup time

Incorrect handling of 10 bit YUVA inputs - 5.6 merge

Maya 2024 doesn't support Viz Maya plugin

Optimize transform update

Scenes with Alpha behave abnormally in SuperChannels transitions
Stop/Pause/Tags are not considered in Undo/Redo

Text: global config for default font style

Used lens distortion parameters not in sync with main scene

Virtual window renders wrong if inside a GFX channel and the camera is switched
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Key Summary

VIZENG-34824 | Viz Engine shader performance degrades over time

VIZENG-33601 | VizEngine does not always switch back to GH main after main shutdown and startup

26 issues

3.9.2 Installation

* Do not use the C4D Version 15R2 patch file(s) unless you are using this version. Otherwise, it prevents
Cinema 4D R16 from starting up.

* When uninstalling Viz Engine, the installer might report that links could not be removed. Please check that
none of the desktop.ini files of Windows have write protection. For example, Skype seems to change the
permissions of some desktop.ini files with every update.

3.9.3 Windows 10

* Right-clicking on the Taskbar icon of Viz Engine starts a new instance. Starting an additional VizGui process
is prevented on Windows 10.

* Error message "Windows Media Player Rich Preview Handler has stopped working while opening specific
clips with Softclip x64". To fix open Windows Explorer > Tools > Folder options > View tab, and
deselect Show preview handlers in the preview pane.

3.9.4 Videowall

¢ |t might happen that Viz Engine is running at half speed on videowall, but goes back to full speed if another
window comes into focus. If so, start viz.exe -y -w,instead of the regular videowall mode viz.exe
-n -w.
® GFX channels with Alpha != 100% decrease render performance. On video wall setup,
gfx_channels_antialiased = 0 should be turned off in the Viz Configuration

section RENDER_OPTIONS.

¢ Windows scaling can lead to unwanted side effects.

® The maximum resolution on videowall setups is limited to 16392px by 16392px.

¢ Enabling video output for audio setups is not recommended for performance reasons. It is recommended to
grab the audio from one of the HDMI/DP outputs of the NVIDIA GPU and use an Audio embedder instead.

3.9.5 Configuration

¢ Specifying a path in the configuration file including the # character is not supported. Such paths are cut
before the # character.
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3.9.6 VizEngine Render Pipeline

¢ Existing Scenes using Global lllumination might need a precompute again to enable debug views.

¢ Background loading of external images (filesystem, network locations, etc.) is not supported. Images from
Graphic Hub should be used.

¢ Flexbox labels in Scene Editor do not support Unicode characters.

3.9.7 Classic Render Pipeline

¢ Scene Transitions within GFX channels or Superchannels are not supported.

¢ Soft Shadow intensity is currently not working together with Global Illumination.

* We recommend using a warmup scene showing all needed assets once. Under certain circumstances, video
and clip surfaces can show up red the first time being used.

* Playing Audio clips on systems with no physical audio hardware available stops the renderer. You need to
turn off audio in the configuration file.

¢ On some systems with hybrid graphics, like laptops, the dynamic swapping must be disabled in the BIOS
and the stronger GPU must be assigned as default.

e Stencil-based shadows (Caster/Receiver) do not work on rotated geometry.

e When changing CurlAuthUnsafe = 1,Viz One Browser does not work anymore.

® VGA Fullscreen Output is only active if offscreen rendering is turned off. Setting offscreen=0 in
section RENDER_OPTIONS enables fullscreen output.

¢ Blending cubemapped images are not supported.

® Cubemapping with Browser plug-in is not supported.

* Fonts need to be re-imported to use new Pathrendering or Razor fonts technology.

® Masks are not supported on Path rendered Fonts (VIZENG-13737).

¢ Do not send other commands than IS_RENDERER_READY and database connection commands before

this command returns 1 , otherwise the renderer and video output might not be initialized.

¢ |f you encounter stability issues with an NVIDIA driver or issues during driver installation, uninstall the old
NVIDIA driver completely, delete the folder C:\Program Files\NVIDIA Corporation\installer2, install the new
driver and select Custom installation, then check-mark the perform clean installation option and finish the
installation.

* Enabling background loading might decrease the render performance by up to 15 frames per second. This is
due to OpenGL requirements.

® M-Zone keyer only works with HD when rendering with full frames.

¢ Decreased render performance in HD since Viz Engine 3.5.0 when the ringing filter is activated. Before Viz
Engine version 3.5.1 there was no ringing filter for HD. Turn off the ringing filter via configuration or scene-
setting to get the same performance.

e Sporadic NVIDIA driver error The NVIDIA OpenGL driver lost connection with the display driver and is unable
to continue. which in turn causes Viz Engine to freeze. Make sure that the driver profile Workstation App >
Dynamic Streaming is selected. Always use the recommended NVIDIA driver for your GPU.

® Possible performance problems with scenes imported from Viz Engine 2.x. Check the following settings
(applies to old 2.x scenes only):
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* Image Combining should be set to Multi Texturing in the Render options in the configuration (or
flag combine_with_multitex = 1 inthe configuration file) to avoid inefficient image
combining.

¢ Set Key Render Mode to Single Pass in the rendering options in the configuration. The Key Render
Mode can also be set on scene level. Available options are:

* Config (inherit the setting from the configuration).
¢ Single Pass (fill and key are rendered in a single pass).
e Double Pass (fill and key are rendered in separate rendering passes).
Key rendering results differ between these options for compatibility reasons.
¢ Use Single Pass scenes imported from Viz Engine 2.x and Double Pass for Viz Engine 3.x scenes.
® The configuration flag exec_all_animations inthe section RENDER_OPTIONS should be setto 0 ifit
is not necessary to execute hidden animations.
e Turn off the VGA preview in On Air mode to avoid performance drops due to multiple rendering of the scene
(applies only to video version of Viz Engine).
¢ Hide containers that are not required for the current animation.
¢ Re-import fonts directly with the Viz Engine.
¢ Grid picking currently only works for Cube and Cylinder geometry.
¢ The behavior of scripts with cyclic dependencies to other scripts is undefined. Avoid cyclic dependencies.
¢ Bad performance when using multiple dynamic scenes, even if they are set inactive. To avoid unnecessary
updates, change the Update mode in Dynamic Scenes to Auto instead of Always.
¢ CLR LOAD command can crash Vizif not used correctly. Required function signature: static int
pwzMethodName(String pwzArgument).
* Alpha setting for DVEs is not correctly supported when a scene is used nested using a GFX channel
(VIZENG-10212).
¢ Glow plug-in drops performance when used on multiple containers and rendered within a GFX channel or
viewport tile (Classic pipeline) (VIZENG-11342).
® Scene transitions do not work when dynamic images from different folders are involved. Dynamic images
always need to be stored directly in the root folder dynamic and references must point there. Dynamic
images in a subfolder of the dynamic folder or any other folder are not found.
* Font option "lighted" has no effect on fonts rendered with type "vector" (VIZENG-18941)
* 16-bit PNG images are not rendered properly when imported with compression.

3.9.8 UnrealIntegration

Note: It is not advisable to utilize the Unreal integration in production environments outside of Game
Mode. For instructions on how to initiate Unreal in Game Mode, please consult the Viz Artist User Guide
Chapter Third Party Integrations.

e Unreal Engine 5.x with Temporal Super Resolution (TSR) enabled can lead to flicker issues when used in
combination with NVIDIA Driver 528.89. Changing to FXAA solves the issue.
¢ Unreal Engine 5.5 with DLSS enabled can lead to memory issues.
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3.9.9 PostRenderer

Because of performance issues rendering fullscreen sequences in UHD is not supported.

Ghosting effect in post-rendered interlaced video: Make sure that the Flicker Filteris setto 0 inthe post-
rendering options of the Video Render plug-in.

Post-rendering does not work properly if onair_no_videoout flag = 1 (Videowall mode).
Post-rendering does not work properly if TriCaster integration is active and the output format is set to User
Defined or Fullscreen.

DVCPRO expects 720x480 in NTSC resolution. Please set the correct output width in AVIRenderer.

The alpha channel cannot be rendered with Intel Indeo 5.10 codec. This codec is not supported.

Viz Engine might crash if certain VfW codecs are used on non-Matrox installations in Post Render Mode.

3.9.10 Matrox

o

Important: When upgrading from 10.4 to 11.x Matrox driver, follow these mandatory steps:
¢ Uninstall old Matrox driver
¢ Cold Boot (Turn off computer for at least 20 seconds)
e Switch Computer on
e Continue installation of new driver

Enable Hardware DVE/(Fast Texture Mode) is only available for two instances.
The configuration ClipIn[n].UseV210 and ClipIn1. ContainsAlpha are mutually exclusive and should not be
enabled at the same time.
The overall delay is one field higher than in previous versions using 103 This is caused by the required A/B
buffer of 10 4.
A program output channel needs to be defined. Pure preview or Cleanfeed is not supported.
HDR output on UHD 2SI requires at least a Quadro P6000 GPU.
Large Canvas setups require a RTX5000 Ada or higher.
Mixing different frame rates with clips processed by a M.264 board is not supported and causes jittering.
Upgrading the FPGA can cause a PCl error during the boot process on certain systems. Unattended
upgrading of the FPGA is not recommended.
Watchdog is only supported in 50/60M and 60Hz frequencies.
When using 3G formats (1080p/UHD) or the Zero-Frame-Delay Mixer, auto-sensing of the sync signal is not
supported due to incompatible H-/V-phases, that are set in the process.
Instead, either Tri-Level or Blackburst must be used together with correct H-/V-Phase. This might result in a
missing key signal (VIZENG-11708).
For dual channel systems, please perform the following steps after enabling the watchdog to ensure the
correct state is written to the Matrox Board:

a. Start Channel 1.

b. Wait until channel has started up and topology has been written.

c. Start Channel 2.

d. Wait until channel has started up and topology has been written.

e. Exit channel 2.
f. Exit channel 1.
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g. Start channel 1.
h. Wait until channel has started up and topology has been written.
i. Start channel 2.
¢ ClipOut channel does not work when Matrox0.VideoOutl.FrameBufferDelay is set to zero (VIZENG-16373).
e UHD Clip Playback with M264 S1/S2/S3 alone requires color conversion on the shader level. (VIZENG-20700).
¢ Two Sample Interleave (2SI) clips played as DVE are not supported.
e Cutting of Audio tracks should not be done at all, as this results in a crackling noise. Always use a cross-fade
to change audio sources.
® Certain M4V clips may cause Viz Engine to lock and flood the console with errors when being played in a
loop.
® Runninginterlaced AVC-Intra 100 clips on M.264 boards may lead to instabilities when played non-stop over
several hours.
¢ Always verify the Destination Connector when changing/adding configurations of output channels.

3.9.11 X.mio3 Boards

e |f the Vizinstance is closed unexpectedly, the X.mio3 topology might become unusable. To reset the
topology, enable ResetTopology in the config file, restart Viz, close it and start Viz again.

¢ Turning on the Cleanfeed Feature increases the delay by one frame.

¢ |tis not recommended to change the frame group of any input signal while Viz Engine is running.

¢ Only two DVE UHD inputs are supported at 50Hz. For 60M formats, only two texture inputs are supported.

¢ Animating UHD DVE scaling might result in jittering. You need to increase the VideoDelayDVE settingto 2 .

¢ Texture delay with PAL/NTSC, and Enable Hardware DVE is five fields instead of four fields. (VIZENG-16955).

* When using watchdog together with a clean feed, the watchdog triggers on the clean feed connector rather
than the program output (VIZENG-16589).

3.9.12 X.mio5 Boards

¢ Standard Definition (PAL and NTSC) resolutions are not supported by X.mio5 IP boards according to the
SMPTE ST 2110 standard.

e Streampunk ledger RDS does not list the Matrox X.mio5 nodes. This is due to some old NMOS APIs that are
partially deprecated.

¢ Riedel Explorer fails listing the X.mio5 nodes. Riedel Explorer automatically selects NMOS API Version 1.3
instead of 1.2. It is possible to select the used API version manually if you switch to static mode and/or
enable version downgrade in the Riedel Explorer.

The X.mio5 board has been tested to support up to 12 Inputs (1080i 50 and 60M) on a 10GbE network.

3.9.13 DSX.core

After the installation of the DSX-core client version of the driver perform the following steps:

1. Unregister mvfDsxCore.dll.
a. Click Start > Run (or use the Windows command line: Search > CMD > (Right click) Run as
Administrator)
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b. Type REGSVR32 /U "C:\Program Files\Matrox DSX-

TopologyUtils\System64\mvfDsxCore.dll" and press ENTER.

2. Shut down http://X.info in the task manager (mveXinfo.exe).
3. Delete mvfDsxCore.dll from the folder C:\Program Files\Matrox DSX-TopologyUtils\System64).
4, Start http://X.info (mveXinfo.exe).

3.9.14 OtherVideo Boards

* When Viz Engine is in On Air mode, there might be audio distortions using Bluefish cards (VIZENG-8853).
¢ Bluefish Supernova S+ cards can only be used in a Virtual Set Environment if the board is synced to
Blackburst/Trilevel.

3.9.15 NDI

Security Updates Windows 11 - KB5063878 and Windows 10 - KB5063709 can lead to traffic drops in NDI output.

3.9.16 NVIDIA

* When the computer is running out of virtual page size and the user keeps ignoring the low memory warnings
in the console, the NVIDIA driver may cause Viz Engine to crash.

® The NVIDIA driver doesn't recognize other GPUs under certain circumstances in combination with video wall
mosaic installations. Remove and reinstall the driver.

3.9.17 GraphicHub

e Communication with the Graphic Hub Server might fail if virtual network adapters are active. Please disable
all virtual adapters or increase the timeout.
¢ If the connection to the naming server fails, please verify the communication port in the config file (Port

19396 ).

3.9.18 Adaptive Scene Design

¢ WindowMask plug-in prevents Flexbox labels from being picked.

3.9.19 Audio

* Unplugging a USB microphone from the machine while EAS is enabled freezes Viz Engine without the
possibility to recover (VIZENG-29571).

3.10 Supported Hardware and Software
This software has been tested to run on:

e Windows 11 (LTSC 2402)
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e Windows 10 (LTSC 21H2) & (LTSC 1809)(1))
* Windows Server 2025, Windows Server 2022

Viz Engine Release Notes - 5.5

(1) Fyture Versions of Viz Engine will no longer provide support for Windows 10 LTSC 1809.

@ ynreal Engine requires a newer Windows 10 version than 1809. UE Integration was successfully tested with 21H2

Note: Only English language Operating System(s) are supported.

3.10.1 Supported Systems

System

Lenovo P3 Ultra / Lenovo P3 Ultra Gen2
Lenovo P620

Lenovo SR655 V3

DELL R7920

HP Z8 G5 Fury

HP 28 G4

HP Z4 G5 (Rack and Tower)

HP Z4 G4

HP ZCentral 4R

3.10.2 Supported GPUs

Blackwell GPUs Ada Ampere
Lovelace @ GPUs
GPUs

Turing Volta Pascal Maxwell

GPUs GPUs GPUs GPUs
Quadro Quadro
P6000 M6000
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Blackwell GPUs  Ada Ampere Turing Volta Pascal Maxwell
Lovelace  GPUs GPUs GPUs GPUs GPUs
GPUs
Quadro Quadro
P5200 M4000
Quadro Quadro
P4200 M2000
Quadro
P4000
T1000 Quadro
P3200
RTX A2000 Quadro
P2200
RTX A3000 Quadro
(mobile) P2000
RTX A2000 Quadro
(mobile) P1000
RTX A1000
(mobile)
3.10.3 Supported Video Boards
Video Board Configuration
Matrox Electronic Systems Ltd
Matrox X.mio5/X2 SDI Up to four 12G SDI input with up to four SDI 12G SDI outputs
variable configuration from 12inOout to 0in12out
Matrox X.mio5/8 SDI Up to four 12G SDI input with up to four SDI 12G SDI outputs
variable configuration from 8inOout to Oin8out
Matrox X.mio5 IP Up to 32 ST 2110 inputs and 32 ST 2110 outputs depending on
used SFPs and resolution
Matrox X.mio3 Full Height Various input/output configurations from 48 to 84
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Video Board
Matrox X.mio3 12G

Matrox M.264 S1/S2/S3/
S4

Matrox DSX LE 5L /4
Matrox DSX LE 4 /8
Matrox DSX LE 4 /4
Matrox DSX LE 4 IP
BlueFish Technologies
Bluefish Epoch Neutron

Bluefish Epoch 4K
Supernova

Bluefish Epoch Supernova
S+

Bluefish Kronos K8
AJA Video Systems, Inc.
AJA 104K Plus

AJA Kona 4

Viz Engine Release Notes - 5.5

Configuration
Two 12G inputs, two 12G outputs

H.264 Encoder/Decoder board

Various input/output configurations from 04 to 40, all in 12G
Various input/output configurations from 08 to 80
Various input/output configurations from 04 to 40

Various input/output configurations from 04 to 40

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Four video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Two video inputs, two video outputs (fill & key)

Please refer to the Viz Engine Administrator Guide for which drivers and driver settings to use.

3.11 Build Information

Platform Toolset: Visual Studio 2022 (v143)

Windows SDK Version: 10.0.22621
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4 Documentation

o Info: Starting with Viz Artist/Viz Engine 5.4.0, the installer no longer installs the Viz Artist User Guide, Viz
Engine Administrator Guide or Viz Plugins User Guide as offline documentation.
Documentation for Viz Engine, Viz Artist and Viz Plugins is available online on the Vizrt Documentation Center:

® Viz Artist User Guide
¢ \/iz Engine Administrator Guide
¢ \iz Plugins User Guide
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5 Installation and Support

5.1 Installation

The installation wizard guides you through the installation process. Make sure to close any running Viz application
prior to the installation. In order to run Viz Artist or Viz Engine independent of a database server, you need to install
the Viz Graphic Hub database software locally.

5.2 Support

Supportis available at the Vizrt Support Portal.
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